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Activation

Upon starting BLACK & WHITE projects 5 for the first time, you will
be prompted to activate the program. Proceed as follows:

Install BLACK & WHITE projects 5 as described by the installation
wizard. Input your serial number. For the box version, this can be
found on the accompanying booklet. If you have chosen to download
the program, you will have received the serial number by email
directly following your purchase.

16 days remaining.

L TT——
Serial Number: |
Please enter your serial number and dlick "Activate”.

| Activate now Later

Finally, click on the “Activate” button. The software has now been
successfully activated!

Note: BLACK & WHITE projects 5 can be installed on up to two
computers using the same serial number.

A second serial number is not necessary. When installing the
program on a second device, simply enter the serial number again
and press “Activate”.
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1. What s New?

BLACK & WHITE projects 5 offers many new features. Here is an
overview of some of the most important developments:

v" New filter Plug-ins for Adobe® Photoshop (all versions from
PS CS6 to CC 2015.5).

v" With several new Presets BLACK&WHITE projects 5 has now
a total of 139 presets. On top of that there is a preset
browser for all presets

v" The interface design has been completely revised and now
supports work with 4K monitors

v" One can now choose the font sizes for menus and titles.
v Ahot key list as well as a list of loadable camera RAW
formats were embedded in the program

v' The GPS coordinates of a photo allow you to directly see
where the photo was shot in Open-Streetmaps.
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v" The RAW-module has also several new functions

Category “FX” with 8 extra effects
Light diffraction correction in the area of colours
dynamic brightness

Trapez distortion
colour dynamic

v" New: comparison of function in preset browser

v' What’s really practical: the optimisation assistant with
different choices of opacity

v' The absolutely novelty in BLACK&WHITE: film grain-module
with adjustable ISO number, six different film grain forms,
masking the film grain and fractal film grain.

v' Many new effects and functions you can find in the selective
drawing module

Increasing contrast

Reducing contrast

Blending in the original image

Mask production in optional brightness/colour

Smoothing brush

Soft-focus effect, reduction, increase on masks

optional mask colour

automatic adaption of masks from selective drawings onto
the distortioncorrection in the RAW - module

v' Composing modus with free downloadable pictures in four
levels in the selective drawing module
v" New photographic film emulations
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v' BLACK&WHITE projects 5 has now 15 new post-processing
effects (105 now in total):

Dissolving Optimisation of the
structure

Mist & Fog reduction Abstract painting

Denoising optimisation Kaleidoscope

Film grain - Analog Frame

Film grain - Fractal Ornament
Logarithmic gradation Brush marks
Optimising the focus Water-reflection
Restoring the highlights

v' Optimisation of the post-processing engine.

v" Two fold speed increase and more




BLACK&WHITE projects 5 — user manual

2. Photos Done Quickly
You can obtain a finished image in just 4 clicks with BLACK & WHITE
projects 5.

1. Load Images
2. Post-Processing Preset Selection

3. Optimisation Assistant

4. Select Image Detail and Save

You can simply drag and drop your images or bracketing series onto
the start screen

How to get the results you want, and fast - the elaborated presets and
looks, individual image adaption and selected drawing allow you to
also go the creative route. BLACK & WHITE projects 5 offers both
options.
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3. Configuring the User-Interface
Optional font size for Menus and titles
In the main menu of the program you will find in View -> font size an
option to customise the size of the letters in the menu as well as in
the titles of the program.

V/5.52.02653 - C:IUsersIsoﬁwarelekboraVDocumentslﬁACK&WPﬂ'E/Tulipsj_

View Extras Add-ons Information

Information windows Ctrl+I er’ B IEI e

—

Exif information window Ctrl+E
Histogram Ctrl+H

Full screen view on/off Ctrl+F

Interface style... (dark grey)
Font size » Small menus and topics
Frame colour: grey card -> automatic SRR

Large menus and topics

C’ Restore window defaults

The font size can be adjusted to the run time of the program. 4K -
monitors gives you the option to enlarge the font size for better
readability of the menu.
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4. Importing Image Material
To load an image, simply drag and drop the images onto the start
screen. Alternatively, you can also use the toolbar buttons or
dropdown file menu.

As soon as you have chosen a photograph and dragged and dropped
it onto the start screen, the dialogue and image preparation will
appear.
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5. Optional: Image Preparation

Click on
Extras/Preparing
image... . Here you can
precisely configure the
image preparation
settings or select the
standard settings and
turn off the image
preparation window
which pops up upon
uploading photos. For the
first steps, select the
standard settings.
Clicking the back arrow at
the bottom left restores
any changes made here
back to the standard
settings, so nothing is
irreversible.

¥ colour space conversion

Adobe RGB 1998

[ wWhite balance

True to shot/camera
Candlelight
att lightbulb

tt lightbulb

tt lightbulb

10



BLACK&WHITE projects 5 — user manual

a. Colour space conversion: [EEEEEEREE:
advanced users can choose
a colour space here - for all
other users, it is
recommended to not make
any adjustments, to avoid
incorrect colour rendering
later.

b. White balance: corrects
colour casts that occur with
shots taken, for example,
in a warmly lit room. To start, leave this setting unchanged.

c. The colour temperature ranges from 1000K to 16500K, which
makes for a powerful tool for establishing warm and cool
moods.

d. The backwards arrow returns all adjustments back to their

initial values.

e. The checkbox at the bottom edge of the window allows you
to choose if you would like to have this window displayed
when uploading images or not.

11
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f. RAW-options: The automatic brilliance optimisation for
RAW files can be activated in image preparation under RAW
options. Frequently it is with camera RAW formats that the
image data will not use all tonal values that are available. The
automatic brilliance optimisation compensates this with the
uploaded RAW images by amplifying the tonal values so that
a meaningful utilised

. . RAW opti
histogram is created i

¥ Automatic luminocity optimisation

for every camera
RAW image.

@ Automatic rotation

g. This arrow exits the image preparation and takes you to

post-processing.

12
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6. Post-Processing: Presets =

A change from previous versions, we are starting directly with post-
processing after uploading the images. Here we can control the
picture’s tone mapping and edit the results with filters and effects.

=
Import @

- no filter -

Natural high quality

Left side of the post-processing
screen: the presets show the
breakdown of the live preview in
categories - “All", “Natural”,
“Land“Landscape”, “Portrait”, “Toning”,
“Custom”, “Surreal”, “"Architecture”,
“Artistic”, and "FX" with the quantity of
presets in the appropriate category.

To begin, we've chosen the “Natural high
quality” preset. Clicking on the preview
image applies the effect to the image in
real time, which will then be displayed in
the middle of the screen.

Discover the wide variety of different
looks by clicking on the 160 different
presets. You will be amazed by the
intriguing styles in the artistic section!

13
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Image after applying the “selenium toning” preset

14
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5 Dot singt €4

All 139 BLACK & WHITE
projects 5 presets at a
single glance. The
“Presets” section can be
separated from the rest
of the interface by
clicking on the "Default
settings" bar, which then
allows you to adjust the
size of the window as
you like.

Would you like to see all the previews for the loaded image or series?
Click on the “All” category and then on the symbol.

BLACK&WHITE projects 5 creates then a browser gallery with all the
presets. For a bigger display click on the image.

15
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This very practical feature is reminiscent of good old contact sheets.
You can create proofs to assess how the image with your favourite
presets would look when printed.

> Preset browser: E

The preset browser allows you to choose from different versions of a
function and is primarily operated with the mouse:

- shifting the segment: hold down the left mouse button, before
moving the mouse

- zooming in: scroll up

- zooming out: scroll down

- choosing the variant: double left click on the image
- setting a referent: left click on the image

- comparison with referent: hold down the right mouse button over
the image

The corresponding short cuts you can find under “menu information -
> keyboard short cuts”.

Click on the symbol ﬁ and BLACK&WHITE projects 5 will show you
the entire preview gallery of that chosen category.

16
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Zoom in now on the variant that you want to compare and set a
reference image.

This reference image you will be able to put on any image through a
left click of the mouse. You can fade in this reference image into the
other image by holding down the right mouse button.

The border surrounding the image in a green dashed line shows you
the reference image so that you can make the comparison.

In this way you can compare any two variants in the browser directly
and visually.

Example: As a reference image you choose the variant “sulfur toning”

and mark the image with a left mouse click. The green dashed line
shows that you have chosen this image

17
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Toning Sulphur
e o

<

Now you look for a different preview image, in this case Preset “sulfur
toning” has been chosen.

Here you can see the preset “artistically impressionist” and
“artistically vintage” in a direct comparison.

Right click on the preset “artistically impressionist” and the reference
preset will fade in. As soon as you let go of the mouse button, you will
see the “artistically vintage” Preset again. This is how you simply and
purposefully compare looks with another before choosing the ones
you like the best.

18
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Selection of your desired variation:
With a double click you chose the variant. The relevant program
settings will be carried out automatically.

Tip:
Your current choice will be automatically set as your reference image,
when you open the window.

» Combine presets

To merge two looks together use the “Combine default presets"
button directly under the categories. These new presets will be saved
under "Custom". It's that easy to expand your numerous options and
accumulate new ideas!

» Name Favourites

Have you found certain presets that you love and instantly want to
have handy?

w Favourites: 3

=% B+3

@ Export

- nio filter -

Click on the top right star in the preset window and add the setting
to your favourites. By clicking the button, previews all of your
favourite presets will be displayed.

19
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i
» Comparison View

Do you want a comparison to the image without tone mapping?
Simply right click on the middle of the image to see the before/after
result. A quick check on the editing process is available at any time.
For an extensive overview with selectable areas and luminance
display, click on the symbol bar.

| Compare Window

> Preview Mode

When this option is activated, the result image will appear as a small
preview size. If this option is deactivated, the picture will appear in its
true size. Please note that processing the preview can take longer
when this feature is deactivated.

20
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> Real Time Processing

When activated, all of the changes that you have made to the preset
settings will be immediately applied to the image and you will see the
outcome of your adjustments directly. If this option is deactivated, you
will only see the changes to your image once you have clicked on the

“calculate anew” button.

» High-Quality Display m

Activate this option to see the preview image in high-resolution. If the
preview is set at 100%, there will be no difference. If you zoominon a
section of the photo however, there is a noticeable difference in
quality.

»  "Original resolution” symbol E

With this button you set the zoom factor back to its original
resolution.

» “Setting the zoom factor to screen size” ﬂ

With this symbol you set the zoom factor to the maximum possible
screen size.

21
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> Border Pixel Display

The border pixel display helps to reveal areas that tend towards
maximal light and dark values that is to white and black. Dark border
pixels are depicted by blue and light pixels by orange.

If you would want to brighten this image, you have to be careful of the
orange border pixels. Light surfaces in the sky should not become too
white, in order to avoid losing detail. In technical terms, these patches
are called “"burned highlights”. The border pixel view helps to find
these critical image areas.

> Import/Export from Presets

Presets from earlier versions can be easily imported. Do you want to
exchange all of your presets with a friend or just secure all of your
treasures? Use the practical export function.

22
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> Filter Presets

Locating presets can be difficult when you have imported presets or
created many additional looks. For example, enter “soft" into the
search bar and only presets relating to “soft” will be shown. For
example presets with the names “Potrait soft skin” or “tritonus soft".
This makes the search a lot easier.

23



BLACK&WHITE projects 5 — user manual

7. Post-processing: finalise
finalise
Now that we have understood the most important part of post-
processing, let's go onto fine-tuning, which can be found on the right

side of the screen under “Finalise". These features are intended to
only to be used to edit pictures further after selecting a preset.

» The magnifying glass

On the right hand side (at the very top) in Post-processing you will find
the 1:1 magnifying glass. The magnifying glass shows you the area
under the mouse in a 1:1 pixel view.

To keep the magnifying glass on a specific point, press down on the
“L" key, while you move the mouse over the screen.

24
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4 Magnifying glass 4 Magnifying glass

Click into the image area of the magnifying glass, to change between
the display modus “divided before/after comparison” and “direct
before/after comparison”.

To free the fixated area of the magnifying glass, press down on the “L"
key once more.

Point of interest

b Bl ror

» Point of Interest

Activated “Point of Interest” renders the current editing only to a
specially defined area of the image. The effects will be applied in their
full form, however only visible in the specified spots, the rest of the
image will be left unaffected. This effect is intended for very large,
high-resolution photos, for example panorama pictures.

» Greyscale Conversion (Spectral Sensitivity)

Here you'll find the amazing new “spectral sensitivity” feature, which
allows you to influence the grey value by selecting a single colour tone
to base the conversion on. It sounds complicated, but it is very simple.

25
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In our example, we have Greyscale conversion

uploaded an image and o "o W
selected the “naturally
neutral” preset to get a
natural grey scale conversion.
The result is relatively dull,
since the red tones have now
become a dark grey.

The motorcross driver and
vehicle do not stand out
enough compared to the
ground. We can change this
by setting the red control to
70% and orange to 50%.

26
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It looks like hours' worth of editing, but it isn't. By specifying the grey
values for individual and clearly limited colours, the image’s
impression can be completely changed, and save you boring,
complicated editing time.

» Film emulation and preview Browser
Photo film emulation

BLACK&WHITE projects 5 has come up  [EEE" e
with a photofilm emulation engine that Moosm A
projects film-looks of the legendary
days of analogue film onto your digital
photos.

Optimisation

In this version you will find 12 new
fantastic photofilm emulations:

27
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Adox Silvermax Fotoimpex CHM 400
Agfaphoto APX Pan 400 Lomo Earl Grey 100
Bergger BRF 400 Plus Lomo Earl Grey 400
Caffenol + C Rollei Blackbird
Foma Retropan 320 soft Rollei Retro 100
Fotoimpex CHM 100 Rollei RPX 25

Rummage through a box of old photos - it"s worth it!

Select a type of film and its specific colour characteristics as well as
the grain and contrast film effects, to apply to your picture

Since the grain of a photo is a very specific characteristic, one is able
to adapt the strength of the grain via a controller. You can regulate
the intensity of individual features as well as the overall effect of a film
look.

> XColour

The X Color Effect gradually builds RS

the initial colour image step by @  HsL ilumination
step back into the edited
black&white photo, so that you can
create cool vintage or bleaching
effects.

28
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After you are finished editing, give it a try and blend in the original
image about 20-35%. The subtle colour tones create a very modern
style. In the above example, the famous Florence Bridge was
processed with the “landscape powerful” preset and then 28% colour
was brought back into the image with X Color. The original colour
image can be seen on the left. Five blending algorithms are also at
your disposal.

» Colour Toning

BLACK & WHITE projects 5 offers 8 additional colour toning filters
that can be extremely creatively used. Colour filters are applied to the
entire image and can be added with just one click. Saturation and
opacity can also be set. If you want to make your own filter, simply
select a colour from the colour tone spectrum.

Colour toning

& & 6 & 4

Colour tone 20

Saturation 50

Opacity 50

29
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F

Here is an example of four of the eight colour toning filters. Since the
toning is transparent, all of the light information remains intact and
the images are not darkened.

30
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> Optimisation Assistant

Optimisation assistant Optimisation assistant

-
==$ Optimisation: natural

-
== Optmisation: natural

Optimisation on Optimisation off

The optimisation assistantis a @
very efficient tool for fast, - Opacty 100
fascinating results. When the
preset is activated, denoising, wam Denoisng
tonal value, clarity, dynamic
and sharpness settings can all be s
adjusted by sliding the control to o d
the left or right. The result can be
seen live. The optimisation
assistant is intelligent; it
remembers the values you
entered, and applies the same T
settings to the next image in the
same way, but tuning the result to
the new motif.

‘v Clarity

If you would like to edit without the assistant, you can simply turn it
off. If you would like to turn off the values that have been “learned” so

(’
far, click on the

Additionally, the assistant can be given optimising specifications for an
entire image style: choose between natural, brilliant, fine, soft,
intense, sober colours, high key and low key.

31
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Optimisation assistant

==# Optimisation: natural

@

Optimisati

» The opacity regulator of the optimisation assistant

The opacity regulator in the
optimisation assistant activates
itself automatically as soon as
one optimisation is activated.
100 % The opacity regulator works on
every effect that optimises the
image as well as the optimising
pre-settings.

Optimisation: natural

¢  Optimisation on Optimisation off

;,.mf Denoising

Pro Tip: Remember that the preset specifications and Optimisation
Assistant are added together. If you select the “landscape powerful"
preset and the “Intense” optimisation, you will get strong, saturated
colours and dramatic contrast. Not to worry, you can quickly change
back to the “Natural” optimisation and have the familiar look of the
“landscape powerful" again. On the other hand, you can compile new
creative ideas and jump between intense, unsaturated and high and
low key looks lightning fast.

32
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> Granulation module

Film grain

195] 188l Natural grain '@

a) Natural grain
In natural grain the different ® B 4+ &4 O i
levels of photographic paper are |8 150 100 .
simulated, which creates a
natural irregularity.
L A4 A Ad
These following parameters are T ®
therefore at your disposal:

200 +

ty 50

- Form
Choose here from six different variants.

® H ¢+ 4 O i

- 1ISO-number
The preset value conforms to the average “restless value” on a
naturally grey surface.

- Size.
The maximum size of a simulated grain.

- Masking

Gives you the opportunity to calculate the granulation in all different
types of daylight or alternatively in light, shade or shade and light.

33
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Film grain

I Natural grain

Here the Masking has only been set for the lights. This way they
receive a natural granulation, while at the same time the sky is
spared.

nA Click on the button creates a new random distribution of grain
and therefore a whole new look.

b) Fractal grain

Film grain Fractal grain simulates a large
scale irregularity, which is created
through the storing and

®; Fractal grain deterioration of photo material.

@ IEI Natural grain

34
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Therefor the following parameters are at your disposal:
- ISO-number

The preset value conforms to the average “restless value” of a
naturally grey surface.

- Quality
Determines the accuracy of the calculation (number of iterations for
the fractal algorithm) of the fractal granulation.

In the granulation module there is no singular best setting, since the
ideal grain size, form and quality is 100% dependant on the motif.
Here you can try out different things and find new creative paths.

u A Click on the button creates a new random distribution of grain
and therefore a whole new look.

» Scratch and Sensor Errors

Corrections

Erase scratches/sensor errors &

Micro-contrast enhancement used in HDR photography unfortunately
shows every unwanted sensor imperfection that every photographer,
despite internal camera sensor cleaning, knows and dreads. Don't
stress - just eliminate them! With the easy to apply correction function
from BLACK & WHITE projects 5, it can even be fun.

Pro Tip: This intelligent correction doesn’t only remove sensor spots,
but other disturbing things too - a deserted beach has never been so
easy to produce. Lightly mark defects in your motif, the program will
automatically substitute these areas with other appropriate parts of
the image.

35
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Here's how to go about correcting:

: Select the brush tool under (6) and click
@ on the point of the image that you would
like to correct. A circle will appear beside
it that will serve as a source.

®
°e =

Move this circle to a place on the image

0: @ 0; that can act as a source for the first
marking. The selected area will then be
Correction areas (0/200) improved based on the source. Prior to
@ - this, you can reveal sensor spots, which

will appear as a bright patch in the image,
with (1).

Selected area

(2) allows you to expose or hide the fixed
areas. Even when the corrections are still
® é active, even if they have been blended in.

Hiding is solely to enable a before and
after comparison.

You can select multiple areas to correct by simply clicking on the
brush symbol (6) and adding another point.

The button marked (3) can blend the targeted corrections in and out,
which also controls clarity.

(5) deletes the added corrections.

The section marked (7) controls the size of the area that is to be
corrected.

You also have the option to automatically search for the best source
area for the improvement. Click on the (8) button.

36



BLACK&WHITE projects 5 — user manual

Button (4) calculates the appropriate correction spots for all of the
points automatically set using (8).

All currently selected corrections can be deleted with the (9) button.

The sensor spots are circled in red. Here, it would have been
necessary for a sensor agreement....

37
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The sensor sﬁot corrector marks all of the pt;tcl;es and determines a
source within the image that can be used as a substitute.

> Post-processing Expert Mode

expert

The Post-Processing expert mode can be found on the right side of
the screen. Here you can configure all post-processing, try new
effects, adjust a selected preset or construct a completely new preset
to meet your desires.

38
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Overview of the Tools:

a) Display Finalisation Assistant
as active/not active

b) Post-Processing Effects (total
105)

c) Selected Effects (made up of the
preset and your chosen post-
processing effects)

d) Settings for Selected Effects

a) Display Finalisation Assistant

It's worth it to take a moment to
see if the changes were made to
the settings for the film engine or
the optimisation assistant. This way
you can check for any unwanted
doubled effects.

Finalisation assistant

no active final ns

4 Post-processing filter (105/105)

E - B E

Denoising - bandir

Sharpen - luminance HD

Effects you have selected (9/9)

B Denoising - contoured

% B Weighted bla
% BN Balance local co

@

Denoising - contoured

-
=g normal

-

4

39
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b) Post-Processing Effects (105)

The list includes 105 different post-processing effects that can be
freely applied and combined. The effects are divided into six
categories, each with a corresponding background colour.

Yellow: border effects 4 Post-processing filter (105/105)

Green: geometric effects
- banding

Turquoise: exposure effects SR ' ='J:fd
g - hotpixe
- multiple

Blue: colour effects

Purple: diffusing effects

Reduce in-motion blurring

Pink: artistic effects Re

Sharpen - fine

Sharpen - luminance HD

Tip: If you are looking for a certain effect and know its name or part
thereof, you can save time by using the search bar.

When you are applying new post-processing effects, check to see if
the optimising assistant is active. If it is, please remember that effects
will act differently, and sometimes more extreme. When constructing
or enhancing a preset, it is best to turn it off. (Button above post
processing).

40



BLACK&WHITE projects 5 — user manual

4 Post-processing filter (105/105)

=S - E

Denoising

luminance HD

c) Select Effects

Have you found an effect that you would like to try out? Simply double
click on it in the post-processing effect list. The effect will now be
shown in the block below called “Effects you have selected".
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The block of selected effects is the Effects you have selected (10/10)
heart of the post-processing area. It Sing -
includes all of the post-processing
effects and the settings for each
individual effect. The filters in the
example are automatically applied
one after the other to the image and
lead to the edited result image.

# W Denoising - banding

- To temporarily deactivate an effect, simply click on the box beside
the effect's name and remove the checkmark.

- Double clicking on an effect removes it from the list.

- Effects can be sorted at will by dragging and dropping them up or
down the list.

Tip:
The order of the effects within the list can have a substantial effect on
the resulting image. It's worth playing with!

Activate the 360° panorama mode in the bottom left box to prepare
your images for a perfect panorama stitching. The images will be
optimised, so that no borders can be seen when the panorama is
assembled.

- The context menu for the effects you have selected has numerous
functions that allow you to activate, deactivate, move or duplicated
effects.
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d) Settings for Selected Effects

Settings for the selected effects can be found directly below the block
for the effects you have selected. The parameters for the currently
selected effects will always be shown here. The available settings and
options change depending on the effect you click on. There are
sliders, gradation and mask curves, colours and pipettes etc.
Alternatively, a numerical value can be entered into the box above the
slider.

The example shows the parameters for the “focus vignetting” effect,
which consist of slide controls and middle-point alignment. Moving
the rulers adjusts the radius and soft focus, which will be immediately
displayed in your final image. Focus

- &
m=$ normal v 100% -

The ruler’s overflow gives you a =
direct indication of how the new E @+ m O

value will affect your image. wesk s

For a portrait, set the effect’s centre
around the model’s nose in order to
achieve an accentuated face and a
soft background.
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> Example Mask Curves Gradation curve
normal v 100% o

This curve regulates the intensity of i

. ) T E W g
the effect for particular bright areas of e X
the image. When you pull a point B Hiear Y
downwards, pixels with this brightness
will be impacted less by this specific
effect, and vice versa.

Here you will find in the top right
hand-side a box with several different
pre-settings. In this example the pre-
setting “bright lights” has been chosen.

For the gradation curve in this example, it means that the lights in the
picture will be brightened, and the dark areas will exempted in order
to create a striking contrast. This is how mask curves give you the
opportunity to selectively influence images. During the editing, the
preview behind the mask curve immediately shows the effect’s
intensity from black (no effect) to white (full effect).
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» Layer Processing Methods
Gradation curve
These features determine the way that

an applied effect appears on a layer.
Effects can thus be enhanced or
reduced, and looks can even be
completely changed, which opens up a
plethora of opportunities to play with.
To apply processing methods, click on
the drop down menu beginning with
“Normal”.

The application of different layer
processing methods on a single effect
leads to completely different results.

-
- 3
==9 rormal

So that you don't have to try out every
single effect, we have a layer mode
browser. With just one click, you have
an overview of all of the processing
methods and can comfortably choose
which method fits the effect best. Give it
a tryl The effects that you can generate
with layer processing methods are
astounding!

=le)
middle
ligh
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> Selective Editing

For every single one of the 105 post-processing effects it is possible
to apply the selected effect to only a certain area. Furthermore,
specified areas of an image can be influenced at different intensities
by different effects. The selective editing can be controlled in the
parameter area of each effect and you can open the accompanying
window with the button at the far left.

At the bottom of this window there are three blocks with six, three
and two buttons.

This example precisely shows the “over exposed gradation curve”
effect applied to only the selected area. Since 97% rounding has been
selected, the section is almost rectangular. Selective adjustments
can be very softly blended in.
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6 Block: add, remove, duplicate, flip and delete the selected areas
3 Block: various display modes for the resulting intensity of the effect

2 Block: choice of selected surfaces, very practical if the specified
areas are very small or overlapping

You can add up to 32 amplifying (positive) or reducing (negative) areas
for the current effect. The size and position can be determined
directly in the image, optionally in the corners or on the sides of the
area.

The roundness of the rectangle as well as the sharpness and severity
of the selected area can be adjusted with the three controls at the top
of the window. The result will always be instantly displayed upon
releasing the mouse button.

> Selective editing - gradient module

You can choose from every post-processing effect in the area of
selective editing a course (gradient) of 56 premade models with a
single click.

To activate the desired post-processing effect from your chosen
effects, click in the underlying parameter area on the gradient- slider.
A window will open with different types of gradients. From there
choose with a left click your desired type of gradient.
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» Overview of Certain Keyboard Shortcuts:

Cursor Buttons: move the current, active, selected area

Ctrl/Alt + Cursor: fast movement of the current, active, selected area
1,2,3: switch the display mode

Delete: deletes the current, active, selected area

Esc: closes the window

Upon closing the window, the chosen effect will only be

applied to the selected area and displayed in the middle
of the screen.

You can transfer other effects to the selected area with the “Copy” and
“Paste” buttons, without having to retrace the selection again.

This button deletes all selected areas of the active filter, of
iad course with a confirmation prompt first.
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» Custom Presets

One thing is certain, regardless of which settings you have changed, if
you have applied additional filters or adjusted a filter's settings, the
selected preset has been modified and to the right of the preview
image is the following symbol:

Landscape ND gradient filter

Clicking will reset the preset
back to its initial state. Careful:
All of the modifications applied
up to this point will be undone!

Clicking saves all of the
changes in a new preset. A
dialog box will open where you can enter a new name for your preset
or confirm the suggested one. The system will name it “Copy".

The preset will be saved and moved to the “Custom" presets category.

G bl
2 Copy default settl@ .@lﬂ

Enter name:

ND gradient filter (Copy)|

OK Cancel

The new preset has been additionally generated and the starting
preset is preserved. You can also never overwrite a default preset!

Let's switch now to the “Custom" preset category.
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Here we can find our first custom preset.

There are a few new symbols to the right of the preview image:

Is this the favourite preset
that you have made? Mark it to
find it right away next time!

Have you changed this preset B+m
and don't want to lose this new Import Export
look? Then create a new one! TR
Reset the most recently btk
changed settings for the newest
preset

You have readjusted once
again? No problem. Save the
changes with the disk symbol

P
Change the preset's name

Frame  Frame

= You can also delete your
custom preset entirely Natural framed 1

n Use this to enter a search
filter. For example, enter the
search filter “Frame”, and
subsequently type the term into
the search filter bar directly under
“Import".
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All presets with this search filter will be displayed. You can enter the
names of places you've holidayed and all of the presets that you used
for those specific holiday photos will then be easy to find and to apply
to other pictures.

The filter drop down menu to the right already contains “Frame", and
you can simply select it from the entered search filters.
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8. Local Adjustments and Selective Drawings
The new highlight tool from BLACK & WHITE projects 5 deserves very
special attention. Firstly, this tool selectively edits chosen areas
without complicated masks done by hand, like other photo editing
programs. BLACK & WHITE projects 5 includes a completely newly
developed intelligent border recognition algorithm that independently
identifies borders, lines, differentiations and light differences in
drawing mode. The boundaries of the area that the mouse skimmed
over are saved as a mask. These easily and precisely set masks serve
as the basis for 8 important image enhancements: “Shading",
“llluminating”, “Back to previous colour”, “Intensifying colour”, “Reduce
colour”, “Strengthen details”, “Reduce details” and “Sharpen”. A mask
can even be saved as its own image file and used in other photo
editing programs.

Local adjustment

“
4 *\ Selective drawing z

It's easiest to see how the whole thing works through an example
image. First, let's open the selective drawing window (post-
processing/finalise - bottom right). As example image a single RAW file
of a typical flower motif will be used. In this case we want to have the
flower petals a lighter shade so that you can differentiate them more
easily from the dark leaves.
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1.Select editing objective

For this case, select “llluminating”. Make sure that the selected
mask function is activated and the green checkmark is showing.

Masks
FX [l

= Tlluminating

- -

/
2. Activate drawing mode

3. Activate filling mode <
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4. Run the mouse over the contours without clicking. You can
decide and correct the
brush size afterwards.

5. Now look at the mask display. The object where the borders
were automatically recognised is now depicted. Click and hold,
and then trace
your mouse along
the edges of your
chosen object until
it is completely
selected. In the
blink of an eye we
will see the effect
as well as the
overlying mask.

6. Once fully selected, blend the mask out by moving the mask
intensity control to the left.

7. Now you only see the effect, that is, the brighter clouds - our
objective was “llluminating”. Now you can adjust the intensity of
the effect by sliding the control towards the + or -, according to
your preferred strength.

8. Done! The selected areas have been brightened, while rest of
the image has not been touched
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9. Click on “Close”. You will be returned to post-processing and
the selective change will be applied.

10. Use your quickly made mask for a further effect. Go back to
the selective drawing. Our selective mask has remained.

3
Click on and copy the mask to the clipboard. Switch the mask

)
to “Sharpen” and use the i to paste the mask back again. Now
you have sharpened just the rocks, and the other parts of the
image were not influenced.

11. Every selectively applied effect can be activated and
deactivated with the green checkmarks.

12. Borders have different intensities in every image. Presets
normally do just fine, but sometimes it is necessary to adjust the
contour and sharpness settings in order to reach perfect fine-
tuned results.
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13. Have you drawn outside of the lines, despite the border

recognition? You can easily remove it with the eraser. If you
only want to remove a small section, use the eraser with
limitation. When set to 50%, you can only remove 50% of the
mask, regardless of how much you erase. The limited drawing
mode works in the same way, and only draws at a certain opacity.

14. If you want to mask the entire image except for a small object,
it is a good idea to mask only the small object and then reverse

the mask by clicking on the m

Pro Tip: You have two filling modes to choose from when you want to
fill a mask. When do you use which mask? We used the normal fill
mode (symbol) as in our example for a large surface, which is also
preferred for water and sky areas.

Ray filling mode (symbol) is very precise and favoured for smaller
objects, geometric forms or subjects with straight lines, like in our
example here.
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New in BLACK&WHITE projects 5:

» Optional mask colours
Choose for the presentation of the mask as well as the brush one of
the ready-made colours.

The display will be immediately adjusted to your desired colour.
» Selective Drawing - Creating Masks

Masks can also be created from a colour or brightness.

e &b C

With the button (1) you activate the “Create Mask” modus. You will
find yourself in the standard mode “Create Mask out of Colour”(2). If
you want to create the mask out of a brightness, chose the (3) button.

The tolerance controller decides, how sharp (smaller value) or soft
(higher value) the created mask will be.

While you are in the “create mask” mode your mouse pointer will turn
into a pipette. The colour or brightness in which your mouse pointer is
set, will determine the type of mask being created.
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In the above example we can see how a red mask has been created
for the sky

Tip:

If you want to combine several colours in one mask, simply click on
the desired colours after each other with the pipette on the screen.
The current colour will with every click be added to the current mask.

> Selective Drawing - Smoothing Brush
The smoothing brush (1) gives you the opportunity to draw selective
areas of the mask softly.

To draw an area even softer, just go over the same area with the
smoothing brush several times.
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> Global Mask Functions
In the area of global mask functions are several special modes that
one can use directly.

Masks
=

Show original image
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1. Reducing the entire mask outline

becomes

2. Increasing the entire mask outline

becomes

3. Soft-focus effect on the entire mask

becomes

With global functions there are two buttons - the left button fulfils the
function with a lower effect while the one on the right with a bigger
effect.
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> Toreset the function of a mask
Every mask can without any influence on the other masks be reset to
its original state. You simply click on the waste paper basket button

(1)

Masks

= Intensifying colour
= Intensity +

After clicking on the button a security query will follow, so that no
important work can be lost by accident.

> Adaptation of automatic masks onto the
“Distortioncorrection” of the RAW module
Selective drawing works directly with the RAW module. This includes
the “Distortioncorrection” that is part of the RAW module and that is
applied completely automatically on several drawn masks.
In the example we have an image, where the sky has already been
masked.
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When we now subsequently correct in the RAW module the horizon
within the image, then the drawn mask will automatically adjust itself
to the “Distortioncorrection”.
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9. Composing-modus

In the Composing modus of selective
drawing you have the opportunity to
build up to 4 levels of images into your
current motif.

To switch into the composing modus,
click on the “composing” button (1).

From the list of choices (2) you can
choose with which composing level you
want to work with.

With the button (3) you activate the
currently chosen mask. Now you can
through a click on the frame of the
image (4) upload any image you wish to
create the next level.

You can use RAW images, Jpg, Tiff as
well as several other image formats.

Underneath the display screen you will find the parameter area that
begins with two buttons with the following functions:
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(5) Multiple application

Reduce the size of the image on a different level than the one that
youre currently working on. With this option you will be able to
stretch the reduced image outwards (up, down, left, right).

(6) Determine the width-to-height ratio

This function allows you to determine the width-to-height ratio of the
uploaded levels, since the width-to-height ratio in an uploaded image
level can differentiate from the current image you " re working on. This
preserves the proportion of the levels.

(7) The Control-parameter

Width-to-height ratio: If the width-to-height ratio isn "t fixed with the
button (6), you will be able to change the width-to-height ratio
however you desire.

Zoom: Choose the size of that image level by zooming in or out
Shifting horizontally: Move the image level to the left or right

Shifting vertically: Move the image of that level up or down.

Exposure to light: Regularly the light from your current image does
not match with the exposure of your other image levels. Here you can
adapt the exposure and darken or brighten the images however you
want, so that they match.
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10.Workflow

> Edit final image further in an external program

BLACK & WHITE projects 5 offers interaction with external programs.
That way you can take a successful image result to another photo
editing program and continue there.

» Open in other projects programs

Click on the “Projects” symbol in the toolbar to open the image in a
different program from the projects series. Use the drop-down menu
beside the symbol to choose one

of the programs that you already @ HDR projects 5 professional w
have installed on your computer. [

» Open in other photo-editing programs

To directly open the image in 2
another photo editing rL'DJ B 'E' .:5
program, such as Adobe
Photoshop, click on the
corresponding button in the
symbol bar.

External image processing

Adobe Photoshop™

Adobe Lightroom™

Adobe Photoshop Elements™

If necessary, go through the settings to show the path to the program.
Click on “Extras” in the menu and select “Settings” in the drop-down
menu:
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Next, click on the “Export” tab. You — e
can enter the name of a photo
editing program here, and save it for Rospeing image. -

later as well.

Batch processing Ctrl+B

Benchmark

Settings Ctrl+P

Create restore point Shift+Z

Timeline Ctrl+T

-> File name_BLACK WHITE projects.t

» Work with a timeline and restore points

This option can be found in the symbol bar at : o
the top edge of the screen: > .E' —

Timeline

“Create Restore Point” saves an in-between
point of the current settings. You can now always return to this stage
of your editing. You can save as many editing restore points as you
like. The timeline displays the restore points and makes it possible to
call up any phase with just a single click:
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Timeline - 5 Undo-Eintrage - 0.14 GB (80.00 GB verfiigbar)

ep 12015 - 11:22:24 ep 12015 - 11:22:38 015 - 11:23:01 ep 12015 - 11:23:12 Di Sep 12015 - 11:23:27

q- “& ma B‘

This function is especially useful when, for example, you are satisfied
with an image, yet want to continue trying out different settings and
effects. Simply set a restore point and carry on editing your picture. If

you want to go back, simply click on your restore k==d in the timeline.
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11.Selecting and Saving Sections of Images m
To save a final image, click on the button in the toolbar, go through
the file menu or use the corresponding keyboard shortcut (Ctrl+S).

» Cropping and captions

As soon as you have initiated to save a file, the cropping and caption
window will open.

roprg 1

At the top are several practical aids for perfect image composition and
cropping.
You can set the aspect ratio and activate guidelines like the rule of

thirds, the golden section or the golden spiral. Practical is also the new
photo centre display that you can obtain by simply clicking on this

button.

The centre of the window shows your final image. Fix the area to be
saved by adjusting the corners and borders of the photo.

At the bottom is an option to enter a caption. You can determine the
size, position and background for the text. The size of the text will be
automatically coordinated to the final cropping.
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You can either crop the image yourself or use one of the 71 provided
formats. ;

< Maintain original ratio

Please note: If you choose the
cropping, e.g. 13 x 18, the final
image will not be saved as 13 x 18
cm, rather as a ratio of 13 to 18.

As soon as the image has been
cropped and captioned, confirm the
save and the following window will
prompt you to select a file format
and name your file.
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12.RAW-Processing RAW

You can upload and edit RAW image data with the integrated RAW
mode. Numerous tools are available to you here, such as
denoising/sharpen, exposure, colour, detail and powerful distortion
capabilities.

@ =m-omMeeRDE™

Interfering chromatic aberration can be easily removed in the
“colour” category.

An overview of the most important RAW functions:

White balance: Here you can regulate the colour temperature. Use
the pipette to select a white balancing colour directly from the image.

Denoising/sharpness: This feature regulates the image’s noise and
sharpness. Control the quality and different types of noise such as
colour noise, banding or hot pixels.
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Colour balance/white balance: Here it's all about colour and
black/white correction. Modify the general colour mood and
neutralise white and black - the icing on the cake for professional
colour correction.

Exposure: Influence lights, shadows, contrast and brightness in the
final image. With the new dynamic exposure you can adapt the
brightness to the contents of the image.

Detail: Fine-tune clarity and micro-details with lights, shadows and
midtones.

Colour:

These colour settings are all about the luminosity of lights and
shadows. You can even reduce the presence of unwanted chromatic
aberrations.

New is differentiating chromatic aberrations by colours:

Green light diffraction
Blue light diffraction

Red light diffraction

These light diffraction corrections allows you to purposefully remove
the chromatic aberrations of a certain colour.

Thereby a lens curve will be calculated backwards on top of the colour
channel.

Palate:
Adjust the saturation of individual colours.
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Distortion: Take a closer look. These mighty tools can straighten out
the horizon, correct camera angles and lens errors. Use “Autofit” to
automatically trim any awkward borders. The reference grid can be
adapted in the distance between the grids as well as in its
transparency. This is how you will always have the maximum overview
when you are correcting your settings.

4 Distortion

This category includes a several
new special effects like a mist & fog
correction, save highlights, sepia
and film grains as well as different
gradients.

Pro Tip:

When you take a landscape shot,
shift the controller to “Gradient
top” to a dark tone and create in
that way a neutral thick (ND) -
process filter.
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General:

Activate the “360° panorama mode” to optimise matching edges of
images in a panorama series. If you have conducted the settings in
RAW mode, click on “apply”.

Save your settings as a camera profile to save time in the future. This
can be reset at any time.
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13.Batch Processing
BLACK & WHITE projects 5's batch
processing allows for automatic
processing of multiple bracketing
series. The function can be found in the
drop-down menu for “Extras” in the
menu bar.

Extras Add-ons

5 Batch processing Ctrl+B

Preparing image...

Benchmark

Settings Ctrl+P

» Create restore point Shift+Z

Timeline Ctrl+T

Note: Remember that looking through folders with several subfolders
can require a lot of time. That's why selecting “C:\" is not

recommended

> Results: Here you can set where the resulting images of the
batch processing will be saved. Select the corresponding
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folder with the “Target directory (. . .)" button or enter the
name of the folder directly into the text box.

Source file Results

File filter

Images: 42

Y Berlin2014_0062_CR2

Y Berlin2014_0063_CR2

» Format: You can choose from five different formats to save
your resulting images. In form of .jpg and .tif, there are two 8
-bit formats and two 16-bit formats, as well as one png
format. JPG images are always the highest quality and TIF files
are saved uncompressed and without defects.

» Editing settings: Choose which filters of the batch you would
like to apply. From here you can also access image
preparation and select presets to be administered to the
image. If you would like to later assemble the edited images
into a 360 Panorama, select panorama mode to eliminate
exposure and contrast edges in the individual images..

Tip: It is better to select a preset from the “natural” or “landscape”
categories if you have a large number of images to process at once.
Extreme effects are better suited to individual images.
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14.Via GPS coordinates directly to
OpenStreetMaps

New: If the GPS coordinates are in your Exif-files (Menu -> Exif
information), then you will be able to locate the place where the photo
was shot when you click on the button “Open GPS coordinates via
Browser”. You will see the place the photo was shot in
www.OpenStreetMaps.org.

i g = i "
- "
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15.Add-ons
With help from add-ons, you can not only import presets from
BLACK&WHITE projects 5, but also entire post-processing modules
can be integrated, which can be necessary to create new preset looks.

1.
2.
3.

Extract the zipped files that you received with the download
Open your BLACK&WHITE projects 5

Click on Menu -> Add-ons -> Import Add-ons

Add-ons
+
* Import add-on

*_ Remove add-on

@ Add-on information

Select Black&White projects Frames (16) in the following
dialog window, open it with a double-click and select the
BLACK & WHITE_Frames.praddon. Then click "Open".

The add-on will now be imported. A confirmation message will
appear:

Please close and restart the program to be able to use the
add-on with all of the other presets.

Open BLACK&WHITE projects 5 and load an image. Select
Menu -> Add-ons -> Addons Information, and confirm that
your filter package was successfully activated.
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8. Filter selection can be
found on the left-hand
side, directly under the
import/export buttons.

-H oO+m

Import Export

Natural high quality
Here only the new, recently
imported presets are displayed.

9. Click the arrow to open
the dropdown menu and
select "Frames". Now
exclusively the new
presets will appear on
the left display box.

Import Export

-no filter -

10. If you would prefer to not filter the presets, the new presets
can be found in the "artistic" category.
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16.Plug-In installation

BLACK&WHITE projects 5 can also be used as a plug-in for Adobe®
Photoshop. Newer versions of Photoshop are automatically detected
by BLACK&WHITE projects 5 during installation and the plug-ins are
installed in the respective plug-in folder. Older versions of Photoshop
might require manual installation.

If you purchased your software as a download or if you have lost your
CD, the plug-ins are also available for download at: www.projects-
software.com/plugins

» Adobe Photoshop & Adobe Photoshop Elements
The following window will appear when installing BLACK&WHITE
projects 5:

elect the version of e =
Photoshop where you would SRS |
like to install the B BT pi T el o e e T Ot
BLACK&WHITE projects 5 [F rstoton 2
plug-in. Click on “next” and e care
follow the instructions from D o ke

the installation assistant.
The plug-ins will then be
automatically installed.
You can conduct the
installation of the Plug-In at a later point as well. Please install
Photoshop before the project Plug-ins!

After the installation of the Plug-Ins, you can open Photoshop again.

Current selection requires at least 47,6 M8 of disk space.

<Back [ nNext> | [ cancel
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In Photoshop you will find under menu item “Filter” the entry
Franzis. Here you will find all of the Plug-Ins listed.

Ctrl+F

Convert for Smart Filters

Filter Gallery...

Adaptive Wide Angle... - Shift+Ctrl+A
Lens Correction... Shift+Ctr+R
Liquify... Shift+Ctrl+X

il Paint...
Yanishing Point. .. Alt+Ctrl+y

The Plugin Site
AKVIS

Athentech Imaging
Auto FX Software

DENOISE projects professional...

Nik Collection

Redfield HDR projects 5 professional...
Topaz Labs HOR projects 5...
Filter online durchsuchen... : SHARPEN projects professional...
The Plugin Site 4
AKVIS 4
Athentech Imaging >
Auto FX Software 4
Cut Out » lgs —
[ = —
Imagenomic »|  COLOR projects 5...
Nik Collection »|  DENOISE projects professional...
Redfield »| HDR projects 5 professional...
B Topazlabs »| HDR projects 5... =

SHARPEN projects professional...

Filter online durchsuchen...

Click on BLACK&WHITE projects 5. The image that you have opened
and edited in Photoshop will now be opened in BLACK&WHITE
projects 5.

80



BLACK&WHITE projects 5 — user manual

Now you will find the program in Photoshop Filter-Plugin mode. You
will be able to edit the image as you "re used to in BLACK&WHITE
projects 5.

When you “re finished editing the image you can send the image
directly back to Photoshop by clicking on the button “apply”.

With the button “discard” you finish the filter Plug-in, without sending
the changes that you have done to the image back to the Photoshop
level. The editing that you have done in BLACK&WHITE projects 5 will
be discarded.

The project program will then automatically close itself. This
mechanism is conducted by Adobe Photoshop and cannot be
stopped.
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» Using Plug-ins with Mac OS X

Adobe Photoshop & Adobe Photoshop Elements

Plug-ins can be found on the start screen in the “Plug-ins” folder.

Select the appropriate folder for your version of Photoshop (we chose

Photoshop CS6 for our example). Double click the .zip file to extract

the plug-ins.

™% BLACK WHITE projects 5
> | Lightroom Plugin
> | Photoshop CC 2014 Plugin
» [ 1 Photoshop CC 2015 Plugin
» | | Photoshop CC 20155 Plugin
» Photoshop CC Plugin
¥ | ] Photoshop CS6 Plugin

| BLACKWHITEProject...Filter_PH6.plugin.zip
| Photoshop Elements 11 Plugin
| | Photoshop Elements 12 Plugin
| Photoshop Elements 13 Plugin
| Photoshop Elements 14 Plugin

vyvYyVvYYy

Next, drag & drop the plug-in

Anderungsdatum
22.08.2016,
22.08.
22.08.2016
22.08.2016
22.08.2016,
22.08.2016,
Heute, 14:36

26.07.20186, 20:51
22.08.2016, 22:36
22.08.2016, 22:36

22.08.2016, 22:36

~
o
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N
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BLACKWHITEProjects5Filter_PH6.plugin (PH7 with other Photoshop
versions) to the plug-in folder for your version of Photoshop, which is

normally labelled as “plug-ins”.
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Start up your version of Photoshop, load an image and navigate to

“Menu -> File -> Export-> BLACK&WHITE projects 5".

@& Photoshop File Edit Image Layer Type Select MEICM View Window

Mosaic ®F

Auto-Select: Group + Show Transform Controls -

Convert for Smart Filters

x Screen Shot 2014-10-18 at 4.50.33 PM.png @ 100% (La
¢ 2 1

Filter Gallery...

Adaptive Wide Angle... X {3#A
Camera Raw Filter... T8A
Lens Correction... ©%R
Liquify... 038X
Oil Paint...

Vanishing Point... X8V
Blur >
Distort >
Noise >
Franzis »>

BLACK WHITE projects 5...

Filter online durchsuchen. [T

With a click you start the Plug-In. The image will now be opened in
BLACK&WHITE projects 5.

Now you will find the program in Photoshop Filter-Plugin mode.
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You will be able to edit the image as you "re used to in BLACK&WHITE
projects 5.

When you “re finished editing the image you can send the image
directly back to Photoshop by clicking on the button “apply”.

With the button “discard” you finish the filter Plug-in, without sending
the changes that you have done to the image back to the Photoshop
level. The editing that you have done in BLACK&WHITE projects 5 will
be discarded.

The project program will then automatically close itself. This
mechanism is conducted by Adobe Photoshop and cannot be
stopped.
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» Adobe Lightroom Plug-ins with Windows

Select Components BAW S
Which components should be installed? k ‘ |

Select the components you want to install; dear the components you do not want to
install. Click Next when you are ready to continue.

[Fullinstallation -

Photoshop CS6 Plugin (64-it) 0,2M8
Photoshop CS6 Plugin (32-Bit) 0,2M8

[¥] Lightroom Plugin 0,1MB

Current selection requires at least 47,6 MB of disk space.

[ <Back [ next> | [ cancel |

Start the installation program and check in the component selection if
“Lightroom Plugin” has been chosen. Copy the plug-in folder
“Lightroom Plug-in” from your CD-ROM.

If you have no CD, the plug-in is also available for download at:
www.projects-software.com/plugins

Subsequently open your Lightroom version. Start Lightroom and

navigate to “File->Plug-In manager” to check if the plug-in has been
activated.
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File | Edit Library Photo Metadata View Window Help

New Catalog...
Open Catalog...
Open Recent

Optimize Catalog...

Import Photos and Video...
Import from Another Catalog...

Import a Photoshop Elements Catalog...
Tethered Capture

AutoImport

Export...

Export with Previous

Export with Preset

Export a5 Catalog...

Email Photo...

Ctrl+0
»

Ctrl+Shift+]

CtrleShifteE
Ctrl+Alt=Shift+E
»

l Plug-in Manager...

Ctrl+Alt+Shift+,

Show Quick Collection
Save Quick Collection...

Clear Quick Collection

Set Quick Collection as Target
Library Fikters

Printer...

Page Setup...

it

Ctrl+B
Ctrl+Alt+B
Ctrl+Shift+B
Ctrle Shift Alts B

Ctrl+P
Ctrl+ ShiftsP

CtrleQ

BLACK WHITE project...

@

unning

Canon Tether Plugin

d running

COLOR projects 5

Facebook

d running

Flickr

HDR projects 4

d running

HDR projects 5

d running

BLACK WHITE projects 5
InstaBert und wird ausgefihit

oo ©¢ ® ® © ©®

Leica Tether Plugin

anclrinning

Adobe Add-ons...

Lightroom Plug-in Manager

¥ Status
Path: C:\Use
ET
Version: 1.1.2.7

Status: This pl
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LR: BLACK&WHITE projects 5: Installed and executed

Mark a bracketing series in your lightroom library. Right-click on the
image directly in Lightroom and select ,Export -> Export to
BLACK&WHITE projects 5”.

et Lolor Lavel »

Export...
Export with Previous

Add to Quick Collection

Rotate Left (CCW)
Rotate Right (CW)

Remove Photos...

View Options..

Or: Choose “File -> Export with Preset -> Export to BLACK&WHITE

projects 5“.

New Catalog.
Open Catalog...
Open Recent

+

Optimize Catalog..

Stacking 4 Bumn Full-Sized JPEGs.
Create Virtual Copies Export to DNG
Metadats Presets » GO

BLACK WHITE projects 5
Export to BLACK WHITE projects 5

Export to COLOR projects S

HOR projects 4
Export to HDR projects 4
HDR projects 5
Export to HDR projects 5

Import Photos and Video.. Ctrle Shift-1
Import from Ancthes Catalog...
Import a Photoshop Elements Catalog...
Tethered Capture ,
AutoImport ,
Export... Ctrl+ Shift-E
[ Export with Preset , Prese

e

Emil Photes.. Epork o 085
For Email
Plugein Manager.. Cule Al Shitte, .
Pluigein Extras » BLACK WHITE project
Show Quick Colection culs Export o BLACK WHITE projects 5
Save Quick Collection. CtrbeAR+E
Clear Quick Collection CtrleShift+ B Export to COLOR projects 5
' ect o1 Target AR B HOR ects 4
et to HOR s d
Libary Fiters lh‘” Il
O s

Printer Culep Exportto HDR projects 5
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> Adobe Lightroom Plug-Ins with Mac OS X

The Plug-In for Adobe Lightroom will not be automatically installed
with MAC OS X. To integrate it into Lightroom, continue as follows:

Install BLACK&WHITE projects 5 to the program link of your Mac.
Copy the plug-in .zip file from the “Lightroom Plug-in” folder on your
CD-ROM. Double click on the .zip file to extract the plug-in to a folder
where you want it to be located.

We recommend the folder where also your presets are stored:

“Benutzer(Users)/username/BLACK&WHITE Projects 5“.

22 Dropbox

iCloud Drive

B hiehmann-pc

O MacDan

]

Start Lightroom und navigate to “File ->Plug-In Manager”.

Click the “Add” button in the Lightroom Plug-In Manager.
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B Lightroom Plug-in Manage

Lightroom Plug-in Manager

» Plug-in Author Tools No diagnostic messages

Choose the relevant Lightroom-Plug-In of BLACK&WHITE projects 5
that you have just copied to your computer, by navigating towards it.

If the Plug-in is not instantly marked with a green active dot, close
Lightroom and start it again.

Now the Plug-In should be installed and be up and running.

You have now several options to get your image from Lightroom to
BLACK&WHITE projects 5.
“File-> export with file-> export to BLACK&WHITE projects 5".

OR:
Right-click on the image directly in Lightroom and select ,Export ->
Export to BLACK&WHITE projects 5“.
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Lock to Second Window 0

Show in Finder
Go to Folder in Library

Go to Collection >
Set Flag >
Set Rating >
Set Color Label >
Add Shortcut Keywo
Stacking >
Create Virtual Copy
Metadata Presets >
Transform >
Metadata > \ Export... - :
S ipot i Gevions
Email Photo Lightroom Presets
Burn Full-Sized JPEGs
Add to Quick Collection and Next B Export to DNG
Remove Photo... For Email (Hard Drive)
- For Email
View Options... #J Lightroom-Vorgaben
Background Options > For Email (Hard Drive)
For Email
Burn Full-Sized JPEGs
Export to DNG
HDR projects professional
Export to HDR projects 5professional
SHARPEN projects
Export to SHARPEN projects
User Presets

¥
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17.Keyboard Shortcuts

Overview of the integrated Keyboard shortcuts

In the main menu in the area of information you will find an overview
of all available keyboard shortcuts. Click on this item to open the
overview.

Information

BLACK WHITE projects homepage @
i Show shortcuts...

Supported RAW formats...

) About BLACK WHITE projects...  Shift+FL

In the overview you will be able to scroll through the different areas,

where you can take shortcuts.

]

To have constant access to the overview via a separate window, you
can use the function ,open in browser“(window bottom left), which
will show the list in a standard browser.

You will also be able to print the keyboard shortcuts from there.
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18.Integrated list of supporting camera RAW-
formats

In the main menu in the area information you will find an integrated
list of supporting camera RAW-formats sorted by manufacturer.

Information

(@ BLACK WHITE projects homepage @

B2 Show shortcuts...

[ o] Supported RAW formats...

‘v?' About BLACK WHITE projects... Shift+F1

If you chose this menu item a camera RAW-format window will open.
i

In the top area of the window you will find a selection of choices, with
which you will be able to filter the list for singular camera
manufacturers. This way you will find your camera faster.
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To have constant access to the supporting camera RAW- formats via a
separate window, you can use the function ,open in browser“(window

bottom left), which will show the list in a standard browser.

You will also be able to print the supporting RAW-formats from there.
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Photo credit:

Imagery provided by the members of the FRANZIS projects team and
the programmers.

Special thanks to Mr. Falko Sieker for providing several exposure
bracketing series and single images for testing purposes. The majority
of the screen shots found in this user manual are results of Mr.
Sieker's bracketings.
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Support

If you have questions regarding the installation, problems or errors of the software, please
contact the FRANZIS customer support team.

Contact form: https://www.projects-software.com/

Please understand that your questions can only be answered directly by FRANZIS
customer support. This is to give us the opportunity to constantly enhance our customer
service for you and to make sure that you receive only the most qualified answers to all of
your questions as fast as possible.

This is how our customer support works best:

Please have the most important details about your computer and about our product at
hand when you call our customer support. These include:

. Name of the product

. Product ISBN (which you can find on the back of the packaging, above the easy
to spot barcode).

. Operating system of your computer

3 Technical details of your PC including all your peripheral devices
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Copyright

Franzis Verlag GmbH has prepared this product with the greatest possible care. Please
read the following conditions:

All the programs, routines, controls, etc., contained in this data media or within this
download are protected by their respective authors or distributors as mentioned in the
respective programs. The purchaser of this data media or of this download is authorised
to use those programs, data or data groups that are not marked as shareware or public
domain for his/her own purposes within the provisions of their designated use. He/she is
authorised to use programs or parts of programs that are marked as shareware, freeware
or public domain within the restrictions given by the respective programs or parts of
programs. A reproduction of programs with the intent of distributing data media
containing programs is forbidden. Franzis Verlag GmbH holds the copyright for the
selection, arrangement and disposition of the programs and data on these data media or
these downloads.

The data and the programs in this data media or within this download have been checked
with the greatest possible care. Considering the large quantity of data and programs,
Franzis assumes no warranty for the correctness of the data and a flawless functioning of
the programs. Franzis Verlag GmbH and the respective distributors do not undertake
neither warranty nor legal responsibility for the use of individual files and information
with respect to their economic viability or their fault-free operation for a particular
purpose.

Additionally, there is no guarantee that all the included data, programs, icons, sounds and
other files are free to use. Therefore the publisher cannot be held liable for a possible
breach of third party copyrights or other rights.

Most product designations of hard- and software and company names and labels
mentioned in this product are registered trademarks and should be treated as such. The
product designations used by the publisher are basically as the manufacturer describes
them.

© 2017 Franzis Verlag GmbH, Richard-Reitzner-Allee 2, 85540 Haar, Minchen
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